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About spreadsheets
You can use a spreadsheet to enter and calculate data. A spreadsheet
consists of columns and rows of cells. You can enter data directly into the
cells of the spreadsheet and perform calculations that are based on the
data by using formulas. You can make changes to the data and see the
results of calculations automatically. You can also sort, filter, and find data
in a spreadsheet. The following example shows a spreadsheet on a Web
page designed to be used as a mortgage calculator. When you change
the values in the bordered input cells in the browser, the spreadsheet
calculates the mortgage payment.

Browser and license requirements
Saving changes
Disabled features
About the Spreadsheet Web Part
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About XML lists
When a user or the designer of a Spreadsheet component queries and
imports data from a data source using a data retrieval service or a Data
Retrieval Service Connections file (.uxdc), the data is displayed in a table
structure that is called an XML list. An XML list behaves much like a
datasheet in a database program: each row in the list is treated as a
single record when adding, deleting, filtering, and sorting items in the list.
An XML list is associated with a query that can be refreshed to display
current information from the data source. You can also edit this query to
provide different query parameter values, select different fields, filter data,
and sort data so you can efficiently retrieve just the subset of data you
want.

An XML list has the following visual features that distinguish it from other
ranges in a spreadsheet.
A frame clearly outlines the data in the XML list. Data inside the frame is
returned from the data source; data outside the frame is not part of the
data returned from the data source.
The XML list can display column headings that are not part of the data
retrieved from the data source, so your headings never get sorted with
the data or excluded when the data is filtered.
The XML list displays a new row at the bottom of the list called the insert
row to make adding a new record simple: just click in the insert row and
type.
If the designer has not locked the entire XML list or disabled other
features of the XML list, working with data in an XML list behaves as
described in the following sections.

Adding records
Pasting records
Deleting records
Sorting records
Filtering records
Inserting and deleting columns
Calculated columns
Working with the associated query

Browser support for spreadsheets
To work with interactive spreadsheets, you must have Microsoft Internet
Explorer 5.01 with Service Pack 2 (SP2) or later, the Microsoft Office
Web Components installed, and an appropriate Microsoft Office 2003
license. If you do not have an Office 2003 license, you can install the
components and view them on a Web page, but you cannot interact with
them.
Note The Spreadsheet Web Part has the same license requirements as
the spreadsheet component. For more information about the
Spreadsheet Web Part, see "About the Spreadsheet Web Part" in About
spreadsheets.

About Microsoft Office Web Components
Microsoft Office Web Components is a set of ActiveX controls installed
with Microsoft Office 2003. With Office Web Components installed on
your computer, you can interactively use a spreadsheet, a PivotTable list,
and a chart on a Web page in Microsoft Internet Explorer 5.01 with
Service Pack 2 (SP2) or later.
If Office Web Components is not installed on your computer but you have
an Office 2003 site license that permits intranet distribution, you can
configure the components so that users will be prompted to download
Office Web Components from your corporate intranet. This allows users
at your site to use a data access page without having Office 2003
software installed on their computers.
For information about how to configure Office Web Components, see the
Microsoft Office Resource Kit Web Site.

About View-only mode for Office Web Components
If you do not have a Microsoft Office 2003 software license installed on
your computer or accessed via a Microsoft Office 2003 application, you
can view a Microsoft Office Web Component— a Spreadsheet
Component, Chart Component, or PivotTable Component— on a Web
page, but you can't interact with it.
To be able to interact with and use full functionality of the component you
are viewing, you must install Microsoft Office 2003 or have access to an
Office 2003 license. If you are in a corporate or group environment,
check with your network administrator for assistance.
When you are in View-only mode, you can:
View data.
Print.
Select and scroll.
Use hyperlinks.
Resize a component.
Select sheets in the Spreadsheet Component.
Expand or collapse members in a PivotTable list.
Refresh data in a PivotTable list.
Use the About, Help, and Refresh commands. Help topics that deal with
interactivity (such as formatting cells, dragging fields, sorting, filtering,
and so on) do not apply.
All commands except About, Help, and Refresh are unavailable in Viewonly mode.
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About accessing a data source on a different domain
The spreadsheet attempted to access data on another domain, but failed
due to one of the following reasons:
The site being accessed by the control is not included in the list of trusted
sites.
In Internet Explorer, on the Security Settings dialog box, under
Miscellaneous, Access data sources across domains is either set to
Disable, or set to Prompt and when prompted, you clicked Cancel.
To enable access across domains, do the following:
Enable prompting
Add the site to the list of trusted sites
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About getting design help for spreadsheets
Some of the content in this topic may not be applicable to some
languages.
When you view and interact with a spreadsheet in your Web browser, you
are working with a component that was created in another program called
a design program. In a design program such as Microsoft FrontPage or
data access pages in Microsoft Access, you can add the data that you
want in the spreadsheet, add the spreadsheet to a Web page you're
designing, and publish the Web page to a Web server. Help about
designing a spreadsheet is available from within the design program.
To learn more about designing a spreadsheet, first choose a design
program to work in. You can start in any of the supported design
programs, and then later work on the same spreadsheet in a different
design program if you need different design features.
Getting help in design programs
Getting help with writing scripts and programs that use spreadsheets
Getting help for the Spreadsheet Web Part
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Keyboard shortcuts in spreadsheets
For information about the keys to activate and deactivate the Microsoft
Office Spreadsheet Component on the page, see Help in your design
program.
Keys for displaying shortcut menus
Keys for moving and scrolling in a spreadsheet
Keys for moving with SCROLL LOCK on
Keys for working with sheets
Keys for entering data on a sheet
Keys for working in cells
Keys for formatting data
Keys for editing data
Keys for inserting, deleting, and copying a selection
Keys for moving within a selection
Keys for selecting cells, columns, or rows
Keys for working with AutoFilter drop-down lists
Keys for working with Help
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About spreadsheet tools, commands, and options
Toolbar
Commands and Options dialog box

Show or hide the spreadsheet toolbar
1. Right-click a cell in the spreadsheet, click Commands and
Options on the shortcut menu, and then click the Workbook
tab.
2. Under Show/Hide, select or clear the Toolbar check box.

Show or hide the Commands and Options dialog box
Do one of the following:
To show the Commands and Options dialog box, click Commands and
Options
on the spreadsheet toolbar.
To hide the Commands and Options dialog box, click Close
upper right corner of the dialog box.

in the

Add or remove sheets
1. Click Commands and Options
on the spreadsheet toolbar,
and then click the Workbook tab.
2. Under Worksheets, do one of the following:
To add a sheet, click Insert. Repeat to add multiple sheets.
You can change the name of an inserted sheet by selecting the
name in the Sheet name list, typing a new name in the Sheet
name box, and pressing ENTER.
To remove a sheet, click the name of the sheet in the Sheet
name list, and then click Delete.
The sheet and its data are permanently deleted.

Change the name of a sheet
1. On the spreadsheet toolbar, click Commands and Options
and then click the Workbook tab.
2. Under Worksheets, in the Sheet name list, click the name of
the sheet you want to change.
3. Type the new name in the Sheet name box.
4. Press ENTER.

,

Change the order of sheets
1. On the spreadsheet toolbar, click Commands and Options
and then click the Workbook tab.

,

2. Under Worksheets, in the Sheet name list, click the name of a
sheet you want to move.
3. Next to Order, click Up

to move the sheet toward the

beginning of the workbook, or Down
sheet toward the end of the workbook.

to move the

Show or hide column headers or row headers
Column headers are the letters in gray cells (or in cells of another color,
depending on your Microsoft Windows display settings) across the top of
the spreadsheet, and row headers are the numbers in gray cells down
the side of the spreadsheet.
1. On the spreadsheet toolbar, click Commands and Options
and then click the Sheet tab.

,

2. Under Show/Hide, select or clear the Column headers or Row
headers check boxes.

Show or hide gridlines in a spreadsheet
1. On the spreadsheet toolbar, click Commands and Options
and then click the Sheet tab.
2. Under Show/Hide, select or clear the Gridlines check box.

,

Show or hide the sheet selector
The sheet selector consists of the Sheet Name tab and the Sheet list,
the second of which appears when you click the arrow on the tab.

1. On the spreadsheet toolbar, click Commands and Options
and then click the Workbook tab.
2. Under Show/Hide, select or clear the Sheet selector check
box.

,

Save changes
Changes you make to a spreadsheet in the browser are available during
the current browser session only. To save changes to data, do one of the
following:
On the spreadsheet toolbar, click Export to Microsoft Excel
and
save a copy of the spreadsheet as a Microsoft Excel worksheet.
Copy the spreadsheet data to Excel or another program on your
computer, and then save the data in that program.

Undo changes
To undo the last change you made in the spreadsheet, click Undo
on
the toolbar. You can undo multiple changes (up to 16) by clicking Undo
more than once.
Changes you make in the browser are not saved. To undo all changes
made during the current session, close the page, and then re-open it.

Print a spreadsheet
To print a spreadsheet from the browser, you must print the entire Web
page.
In Microsoft Internet Explorer, click Print on the File menu.
Note If the spreadsheet is wider or longer than the printed page, the
areas that don't fit on the page are not printed. For more control over how
the data is printed, including the ability to print a long list and set page
breaks, you can export the spreadsheet to Microsoft Excel by clicking
Export to Microsoft Excel
on the toolbar. For information about
printing from Excel, see Excel Help.
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About entering text, numbers, dates, and times in a
spreadsheet
Some of the content in this topic may not be applicable to some
languages.
Entering text
Entering numbers
Entering dates and times

Enter text, numbers, dates, and times in a spreadsheet
1. Click the cell where you want to enter data.
2. Type the data, and then press ENTER or the TAB key.
Notes
To separate the parts of a date, use a slash or a hyphen; for example,
type 9/5/2002 or 5-Sep-2002.
To enter a time based on the 12-hour clock, type a space and then type
AM or PM after the time; for example, type 9:00 PM. Otherwise, the
spreadsheet enters the time as AM.
Precede formulas with an equal (=) sign.
To enter a hyperlink, type the URL address, beginning with a protocol
such as http:// or ftp://, and then press ENTER.
To enter the same data in several cells, select the cells, type the data,
and then press CTRL+ENTER.

How a spreadsheet handles dates in the year 2000 and
beyond
Because the rules that govern the way any calculation program interprets
dates are complex, you should be as specific as possible about dates
whenever you enter them. This will produce the highest level of accuracy
in your date calculations.
How a spreadsheet interprets ambiguous dates When interpreting
ambiguous dates, the spreadsheet makes certain assumptions. For
example, when you enter a date that includes only the month and one or
two digits, the spreadsheet assumes that 1 through 31 is the day and that
the year is the current year. For instance, the spreadsheet assumes that
December 01 is December 1 of the current year, not December of the
year 2001. The spreadsheet assumes that December 32 is December 1,
1932.
How a spreadsheet interprets two-digit years By default, when you
enter a two-digit year value, the spreadsheet interprets the year as
follows:
00 through 29 The spreadsheet interprets the two-digit year values 00
through 29 as the years 2000 through 2029. For example, if you type the
date 5/28/19, the spreadsheet assumes the date is May 28, 2019.
30 through 99 The spreadsheet interprets the two-digit year values 30
through 99 as the years 1930 through 1999. For example, if you type the
date 5/28/98, the spreadsheet assumes the date is May 28, 1998.
Use four-digit years To ensure that the spreadsheet interprets year
values the way you intended, type year values as four digits (for example,
2001, rather than 01).
Change how years are interpreted Your system administrator can
customize Microsoft Office so that different rules determine how dates
are interpreted. For example, your administrator could change the
earliest two-digit year value that's interpreted as a date in the twentieth
century from 30 to another number. Also, administrators can change the
default date format to display four-digit years instead of two-digit years.
To find out if your system uses customized date interpretation, see your
administrator. For information about how to customize date interpretation,

see the Office 2003 Resource Kit.

Change data in a cell
1. Click the cell you want to change.
2. Do one of the following:
To enter a new number or text in the cell, replacing the current
contents of the cell, type the new value.
To change a portion of the contents of the cell, double-click the
cell and make your changes.
3. To accept your changes to the cell, press ENTER.
Note A cell can have only one font and text format.
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About moving and copying data
When you copy a cell, you copy the entire cell, including formulas and
their resulting values, and cell formats. Cells that you copy or move
replace any data in the area where you paste the cells. There are some
differences in how pasting cells affects an XML list. For information on
these differences, see "Pasting records" in About XML lists.
Copying and moving affects formulas
Filtering affects copying and moving
Copying to other programs
Copying in the Spreadsheet Component differs from Microsoft Excel
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Move and copy data
Move or copy whole cells
Move or copy characters within a cell
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Insert or delete rows or columns
Insert rows or columns
Delete rows or columns
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Insert, change, or delete a hyperlink
Insert a hyperlink
Change a hyperlink
Delete a hyperlink
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Clear cell contents
1. Select the cells that you want to clear.
2. Press DELETE.
Tip
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About formulas
What is a formula?
Calculation
Constants vs. cell references
Functions
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Examples of commonly used formulas
Create a sum based on one condition
Count the occurrences of a value or a condition
Calculate a running balance
Join first and last names
Join a date with text
Increase a number by a percentage
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Create a formula
1. Click the cell in which you want to add a formula.
2. Type an equal sign (=).
3. Type the formula.
4. Press ENTER.
Tip

Change a formula
1. Double-click the cell that contains the formula you want to
change so that the formula appears in the cell.
If the cell contains a hyperlink, click a cell next to the cell you
want to change, and then use an arrow key to select the cell
with the formula you want to change. Then press F2.
2. Make changes to the formula in the cell.
3. Press ENTER.

View a formula and its result at the same time
1. Click the cell that contains the formula you want to view.
2. On the spreadsheet toolbar, click Commands and Options
and then click the Formula tab.

,

3. Review the formula in the Formula in active cell (reference)
box. The result of the formula is displayed in the Cell value box.

Insert a total for a range
You can insert a sum for a range of cells automatically by using
AutoSum.
1. Click the first blank cell that follows the data you want to sum,
either below the column of data or to the right of the data in a
row, or select a column range to sum.
2. On the spreadsheet toolbar, click AutoSum

.

A suggested formula is displayed in the cell you selected or in
the cell below the column range you selected.
3. Do one of the following:
To accept the suggested formula, press ENTER.
To change the suggested formula, select the range you want to
sum and press ENTER.

Change when a spreadsheet calculates
When a spreadsheet contains many formulas, it might take a long time to
calculate. To speed up your work, you can change the calculation mode
from automatic to manual so that you can decide when to recalculate the
spreadsheet.
1. On the spreadsheet toolbar, click Commands and Options
and then click the Workbook tab.

,

2. Under Calculation, do one of the following:
To recalculate the spreadsheet whenever a value changes,
select Automatic.
To recalculate the spreadsheet only when you press F9 or click
Calculate, select Manual.
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About using names in formulas
Overview
Guidelines

Define names for cells, formulas, or constants
1. On the spreadsheet toolbar, click Commands and Options
and then click the Formula tab.

,

2. Under Names, type the name you want to use in the Name box.
If you want to define a name that is available to only one sheet
(a local name), precede the name you want to use by the sheet
name followed by an exclamation point. For example, if you
want to name a cell Budget, and make it available only on
Sheet2, type the following in the Name box:
Sheet2!Budget
3. In the Refers to box, type = (equal sign), followed by the
formula, constant value, or reference to the cell or range of cells
you want to name. For example, to name cells A1 through A5 on
Sheet1, type the following:
=Sheet1!$A$1:$A$5
4. Click Define.

Change or delete a defined name
1. On the spreadsheet toolbar, click Commands and Options
and then click the Formula tab.

,

2. Under Names, in the All names box, click the name you want to
change or remove.
3. Do one of the following:
To change the name, type a new name in the Name box and
click Define. Then, click the original name in the All names box
and click Remove.
To change the cell, formula, or constant represented by a name,
change it in the Refers to box, and then click Define.
To delete the name, click Remove.
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About cell and range references
Overview
Relative and absolute references

About calculation
Calculation is the process that a spreadsheet uses to compute formulas
in its cells and then display the results as values. By default, formulas are
automatically calculated when a change occurs in the cells that the
formulas refer to. However, you can change how a spreadsheet
calculates.
Stored vs. displayed values Values are sometimes displayed and
stored differently. Dates and times, for example, are stored as serial
numbers but are usually displayed and printed in one of several date or
time formats. The spreadsheet uses the stored serial numbers in
calculations, which makes it possible to calculate the number of days
between two dates.
The format that stored values are displayed in sometimes depends on
how you choose to format them. For example, you can format a cell that
contains the number 123456789 to display as 1.23E+08 by using the
Scientific format. Or you can format a cell that contains a date with the
serial number 36699 to display as "6/22/2000" or as "22-Jun-2000".
Changing the display of a value does not change the stored value.
The regional settings in Microsoft Windows Control Panel also determine
how number, currency, date, and time formats are displayed. For
example, these settings determine whether years are displayed with two
digits or four digits. See Windows Help for information about these
formats.
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About calculation operators
Operators specify the type of calculation that you want to perform on the
elements of a formula. The Spreadsheet Component includes four types
of calculation operators: arithmetic, comparison, text concatenation, and
reference. Operators calculate in a specific order.
Types of operators
Order in which operators calculate
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About array formulas and array constants
An array formula can perform multiple calculations and then return either
a single result or multiple results. Array formulas act on two or more sets
of values known as array arguments. Each array argument must have the
same number of rows and columns. You create array formulas in the
same way that you create other formulas, except you press
CTRL+SHIFT+ENTER to enter the formula. When you're editing an array
formula, the formula appears in italic formatting.
Array constants can be used in place of references when you don't want
to enter each constant value in a separate cell on the worksheet.
Some of the built-in functions are array formulas, and must be entered as
arrays to get the correct results.
Using array formulas
Using array constants

Show All

Create an array formula
Calculate a single result
Calculate multiple results
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Edit an array formula
If an array formula occupies multiple cells, you must edit the entire range
as though it is a single cell. You cannot change just one element of an
array formula.
1. Select the cell that contains the array formula, or if the array
formula occupies multiple cells, select the range that contains
the array formula.
How?
2. Press F2.
3. Make changes to the array formula.
4. Press CTRL+SHIFT+ENTER.

Select an array formula range
1. Select a cell within the array.
2. Press CTRL+/ (forward slash).
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Move or copy an array formula
1. Select the entire array range.
How?
Click Cut

or Copy

on the spreadsheet toolbar.

2. Select the entire destination range; otherwise, the array will be
pasted into a single cell.
3. Click Paste

.

About using functions
Spreadsheet functions
Functions are predefined formulas that perform calculations by using
specific values, called arguments, in a particular order, or structure. For
example, the SUM function totals values or ranges of cells, and the PMT
function calculates the loan payments based on an interest rate, the
length of the loan, and the principal amount of the loan.
Arguments Arguments can be numbers, text, logical values such as
TRUE or FALSE, error values such as #N/A, cell references, constants,
formulas, or other functions. Each argument you designate must produce
a valid value for that argument.
Structure The structure of a function begins with the function name,
followed by an opening parenthesis, the arguments for the function
separated by commas, and a closing parenthesis. If the function starts a
formula, type an equal sign (=) before the function name.

Nested functions
In certain cases, you might need to use a function as one of the
arguments of another function. For example, the following formula uses a
nested AVERAGE function and compares the result with the value 50.

Valid returns When a nested function is used as an argument, it must
return the same type of value that the argument uses. For example, if the
argument returns a TRUE or FALSE value, the nested function must
return TRUE or FALSE. If it doesn't, the spreadsheet displays a #VALUE!
error value.
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Format cells in a spreadsheet
1. Select the cells you want to format.
2. On the spreadsheet toolbar, click Commands and Options
and then click the Format tab.
3. Do one or more of the following:
Change text font or size
Change a number format
Place borders around cells
Change the background color of cells
Align data in a cell

,

Number formats
Some of the content in this topic may not be applicable to some
languages.
You can change the formats of numbers in a spreadsheet by using the
Commands and Options dialog box, both in the design program and at
run time in the browser. The settings in Microsoft Windows Control Panel
also determine how number, currency, date, and time formats are
displayed. For example, these settings determine whether years are
displayed with two digits or four digits. See Windows Help for information
about these formats.
In Microsoft Visual Basic or a script, you can assign custom number
formats to the data. You can also type custom formats available in the
spreadsheet object model in the Number format box. To find out more,
see how to get help for programming a spreadsheet.
The following number formats are available in the Number format list on
the Format tab of the Commands and Options dialog box.
Format
General
date

Effects
Displays a number as a date and optional time. For example,
8/31/99 05:54 AM.
The fractional part of the number is the time. If a number has
no fractional part, only a date appears. If a number has only a
fractional part and no integer part, only a time appears.

Long date Displays a date according to the Windows regional setting for
the long date format. For example, Thursday, January 25,
2001.
Medium Displays a date according to the Windows regional setting for
date
the month and date separator, and displays two digits for the
year. For example, Jan/25/01.
Short
Displays a date according to the Windows regional setting for
date
the short date format. For example, 1/25/01.
Long time Displays a time according to the Windows regional setting for
the long time format. For example, 8:45:36 PM.
Medium Displays a time in 12-hour format with an AM or PM

time
Short
time
General

designator, omitting the seconds. For example, 8:45 PM.
Displays a time in 24-hour format, omitting the seconds. For
example, 20:45.
Displays a number right-aligned, with no thousands separator,
and preceded by a minus sign if negative. Displays up to 11
digits, or 10 digits with a decimal point, rounding additional
digits to the right of the decimal point. Displays numbers with
more than 11 digits to the left of the decimal point in scientific
format. Displays text left-aligned.
Currency Displays a number according to the Windows regional setting
for currency, with a thousands separator if appropriate and
two decimal places. For example, with the default English
(United States) regional settings, $2,532.75.
Euro
Displays a number as euro currency, with a thousands
currency separator and two decimal places. The euro sign is placed
before or after the number according to the Windows regional
setting for currency. For example, with the default English
(United States) regional setting, 12.35.
Fixed
Displays a number with two decimal places. For example,
68.30.
Standard Displays a number with a thousands separator and two digits
to the right of the decimal point. The Windows regional setting
for numbers determines what's used for the thousands
separator. For example, with a comma as the thousands
separator, 1,800.00.
Percent Displays a number multiplied by 100, with two decimal places
and a percent sign. For example, the value 0.8914 would be
displayed as 89.14%.
Scientific Displays a number in exponential notation. For example,
1.25E+10.
Yes/no
Displays No if the number is 0; displays Yes for any other
number.
True/false Displays False if the number is 0; displays True for any other
number.
On/off
Displays Off if the number is 0; displays On for any other
number.

Merge or unmerge cells
1. Select the cells that you want to merge. Keep in mind that when
you merge cells, only data in the upper-left cell of the selected
range is retained. Data in all other cells that you merge is
deleted.
2. On the toolbar, click Commands and Options
click the Format tab.
3. Under Cell format, click Merge Cells

, and then

or Unmerge Cells

.
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Change the width of a column
1. Make sure column headers are displayed.
How?
2. Select the columns you want to change.
3. Point to the right boundary of the column header of the column
or selection until the pointer changes to .
4. Drag the boundary to the width you want, or, to make the
column width fit the contents, double-click the right column
boundary.
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Change the height of a row
1. Make sure row numbers are displayed on the spreadsheet.
How?
2. Select the rows you want to change.
3. Point to the bottom boundary of the row header of the row or
selection until the pointer changes to .
4. Drag the boundary until the row or selection is the height you
want, or, to make the row height fit the contents, double-click the
bottom row boundary.
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Display text or a spreadsheet so that it reads right to left or
left to right
Use right-to-left text direction or display when your spreadsheet will be
viewed in languages that read from right to left.
Display an entire spreadsheet right to left or left to right
Display text right to left or left to right

About finding data
The Find what feature (Commands and Options dialog box, Sheet tab)
can locate text, numbers, dates, and times that have been entered
directly into cells or that are the results of formulas.
Keep the following guidelines in mind when using Find what options:
Match case By default, Find what is not case sensitive. To find only
those cells with values that match the case of your entry, select the
Match case check box.
Entire cell only By default, Find what searches for cells that include the
value you enter in the Find what box. For example, an entry of "John"
finds cells with strings such as "Johnson" or "Little John." To find cells
that contain only the value you entered and nothing else, select the
Entire cell only check box.
Formatted values The Find what feature searches for displayed values,
not formats. For example, suppose a cell is formatted with the Yes/No
number format. If the cell contains a zero (0), the cell displays the word
No, and you can use Find what to locate the phrase "No". You can't use
Find what to find all cells formatted with a particular color or font.
Search direction The Find what feature searches from left to right
across the columns of the first row, and then from left to right across the
columns of the second row, and so on.
Wildcard characters The Find what feature does not allow wildcard
characters such as question mark (?) and asterisk (*).
Hidden data The Find what feature does not find data in hidden cells or
cells hidden by filtering.

Find data
1. To search the entire spreadsheet, click a single cell, or, to
search within a specific range of cells, select the range.
2. On the toolbar, click Commands and Options
click the Sheet tab.

, and then

3. In the Find what box, type the text or value you want to find.
Notes
By default, Find what searches for cells that include the value
you enter in the Find what box. For example, an entry of "John"
finds cells with strings such as "Johnson" or "Little John." If you
want to find cells that contain only the value you entered and
nothing else, select the Entire cell only check box.
By default, Find what is not case sensitive. If you want to find
only those cells with values that match the case of your entry,
select the Match case check box.
4. Click Find Next.
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Sort data
Data that you want to sort should be set up as a list. A list has similar
items in each column, has labels for the columns across the top row, and
does not include any blank rows or columns.
Sort by a single column
Sort by more than one column
Note There are some differences in how sorting affects an XML list. For
information on these differences, see "Sorting records" in About XML
lists.
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Apply or remove a filter
Apply a filter
Remove a filter
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Sum filtered data
1. Filter the data to display the rows you want to sum.
How?
2. Click the cell below the data you want to sum.
3. Click AutoSum
ENTER.

on the spreadsheet toolbar, and then press

Note The AutoSum button sums only the data in visible rows. To include
all rows in the sum, show all rows and then sum the rows.

About spreadsheets published from Excel
When a spreadsheet has been published from Microsoft Excel, most
Excel features are retained and work the same way as in Excel. Features
in the following list will work differently or will not be retained when
published or saved as a spreadsheet on a Web page.
Excel
formulas,
functions, and
calculation
features
Labels in
formulas
References to
data on other
worksheets
Subtotals
1904 date
system

What happens when published or saved as a Web
page
Labels are converted to cell references.
As long as you publish the entire workbook, references
to other worksheets publish correctly. If you publish only
the referencing worksheet, references to other
worksheets are converted to values.
Numbers and calculations appear correctly. Group and
outline features are not retained.
The displayed dates remain the same, but the serial
numbers for the dates are converted to the 1900 date
system.
Cell value is published.

Precision as
displayed
R1C1
R1C1 reference style is converted to A1 reference style.
reference style
Excel
formatting,
graphics, and
display
features
Rotated or
vertical text
Distributed
alignment

What happens when published or saved as a Web
page
Rotated or vertical text is converted to horizontal text.
Not retained.

Thai alignment
Indented text
Wrapped text in
cells
Graphics
Pattern fills
Dash dot
borders
Multiple fonts in
a single cell
Conditional
formatting
Cell comments
Data validation
restrictions and
messages

Not retained.
Not retained.
Not retained.
Not retained.
Not retained.
Dash dot borders are converted to solid borders.
Not retained. The font of the first character in the cell is
used.
Not retained.

Not retained.
All validation types except Custom and List are
retained. Additionally, cell references in validation rules,
custom input messages, and custom error messages
are not supported.
Auditing tracer Not retained.
arrows
Outlining
Collapsed rows are published as hidden. Expanded
rows are published normally.
Printing or page Not retained.
setup features
Excel file, sharing, and
import features
Shared workbook
information
Lotus compatibility
External data ranges
Web queries
Passwords

What happens when published or saved as
a Web page
Not retained.
R1C1 reference style is converted to A1
reference style.
Values are published. The ability to refresh
from the source data is not retained.
Values are published. The ability to refresh
from the source data is not retained.
Not retained.

Excel list and XML
list features
Excel lists
XML lists

What happens when published or saved as a
Web page
Not retained.
The XML list is retained, but if the list has a totals
row, the totals row is not retained.

Export a spreadsheet to an Excel workbook
On the spreadsheet toolbar, click Export to Microsoft Excel
switch to Microsoft Excel and display the data in a workbook.

to run or

Notes
Because Excel supports 256 columns and 65,536 rows, data in columns
IW through ZZZ and rows 65,537 through 262,144 are not exported from
the spreadsheet. You can, however, copy this data to more than one
Excel worksheet.
When you export data from a spreadsheet to Excel, only the values and
formulas are exported. Links that connect to other data on the Web page
or to other Web pages are not retained in Excel.
When you export some spreadsheet number formats, the data in Excel is
displayed with a custom number format. For example, the Yes/no,
True/false, and On/off spreadsheet formats are displayed with custom
number formats in Excel. For information about custom number formats
in Excel, see Excel Help.

Show All

Troubleshoot error values in a spreadsheet
If a formula cannot properly evaluate a result, the spreadsheet displays
an error value. For example, error values can result when a formula
expects a numeric value but finds text, when a cell that is referenced by a
formula has been deleted, or when the cell is not wide enough to display
the result.
Error values might not be caused by the formula itself. For example, if a
formula shows #N/A or #VALUE!, a cell referenced by the formula might
contain the error.
Following are possible causes and solutions for each error value.
#####
#CIRC!
#DIV/0!
#N/A
#NAME?
#NULL!
#NUM!
#REF!
#VALUE!
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Troubleshoot spreadsheets
Finding Help information
I can't find the help information I want

Entering and editing data and formulas
I can't change cells in the spreadsheet.
I can't wrap text within cells in a spreadsheet.
There is no formula bar in my spreadsheet.
I can't change a hyperlink.
I can't control the size of my spreadsheet.
I can't control whether scroll bars are displayed or hidden in my
spreadsheet.

Filtering, sorting, and finding data
Data does not sort correctly in a spreadsheet.
My spreadsheet list does not show all of my data.
I have merged cells, and I can't filter my spreadsheet.
The Find Next command is not finding data in my spreadsheet.
I published a spreadsheet from Excel, and the AutoFilter drop-down list
is wrong.

Importing and exporting
I can't publish a password-protected spreadsheet from Excel.
My spreadsheet filter is not exporting to Excel correctly.
I get a message that there are too many rows or columns when I try to
export my spreadsheet to Excel.

Working with the spreadsheet in the browser
I cannot interact with the spreadsheet.
When I open a Web page that contains a spreadsheet in the browser, I
receive the error "Cannot open URL."
Clicking the Edit button in my Web browser opens my Web page in the
wrong program.
Error values
I see error values instead of results for formulas.
Accessing a data source on another domain
The spreadsheet attempted to access data on another domain, but
failed.

